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STREAMLINE PRO RELEASE NOTES 
Welcome to the Streamline Pro v12.5.0 Release Notes. Please read this document 
to find important information on areas of Streamline Pro that may not be covered in 
the Getting Started Guide or the User Help system. 
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VERSION HISTORY 
VERSION 12.5.0 – JULY 2025 

WHAT’S NEW 

• ENHANCED ASSET NAME VISIBILITY IN ASSET BROWSER 
Asset names now show more characters with smart middle truncation, making it 
easier to distinguish between similarly named items (like "- SOT" vs. "- VO"). 

NOTE: Existing hover functionality remains unchanged. 

 
DISPLAYS THE IMPROVED SEARCH RESULTS VIEW. 
 

• SECURITY IMPROVEMENTS 
Upgraded the Java™ and Jetty™ platforms to improve security. Support for multi-
domain LDAP authentication. 
 
 
 

CERTIFICATIONS 

UPGRADE NOTE 
If you are using EDIUS X Workgroup v10.34 or EDIUS 11 Broadcast, please ensure 
the appropriate plugin version is installed: 

o For EDIUS X Workgroup v10.34, see StreamlinePro11.2-EdiusX-Plugin. 

o For EDIUS 11 Broadcast, see StreamlinePro11.2-Edius11-Plugin. 
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• OPERATING SYSTEMS 
Windows Server 2019 ( Server )  
Windows Server 2022 ( Server ) 
Windows 10 ( Client ) 
 

• BROWSERS 
For Windows – Chrome 137.0 ( Client )  
For macOS – Chrome 137.0 and Safari 18.3 ( Client ) 
 

• EDITORS 
Adobe Premiere 2025 v25 ( Windows ) 
 

• SUPPORTED ROSS PRODUCT VERSIONS 
Streamline Xchange v10.2.0 
Streamline Xchange Adobe Panel v10.2.0 
Media I/O Suite v12.0 
Inception v17.2 
OverDrive v23.2 
 

• SUPPORTED THIRD PARTY PRODUCTS 
News Room Control Systems (NRCS): 
AP ENPS v9.5 
OCTOPUS v11 
 
Non-linear Editors: 
EDIUS X Workgroup v10.34 
EDIUS v11 Broadcast 
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VERSION 12.4.0 – MARCH 2025 

WHAT’S NEW 

• MULTI-SELECT SEGMENTS ON THE TIMELINE EDITOR 
You can now select multiple segments on the Timeline 
Editor by using the Ctrl+A shortcut on Windows, or the 
CMD+A shortcut on macOS. 
 
 
 

• USABILITY IMPROVEMENTS 

o SAVE CHANGES TO DEFAULT TIMELINE 
If an unsaved session is closed, upon the next login 
you will receive a prompt asking if you wish to re-
open the unsaved Timeline. 
 
 

o PREVENT EXPORTING TO THE SAME 
PLACEHOLDER 
If you attempt to export to a placeholder that is 
already in the process of exporting, you will receive 
a warning prompt. 
 

 
 

BUGS ADDRESSED 

• Fixed an issue where the default timeline would not export in the locally configured 
frame rate. (SP-1421) 

  

 
Displays Multi-selection with a Blue Highlight. 

 
Displays ‘Open Unsaved Timeline’ Query 

 
Displays ‘Failed to export: Export already in 
progress’ Notification 
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CERTIFICATIONS 

UPGRADE NOTE 
If you are using EDIUS X Workgroup v10.34 or EDIUS 11 Broadcast, please ensure 
the appropriate plugin version is installed: 

o For EDIUS X Workgroup v10.34, see StreamlinePro11.2-EdiusX-Plugin. 

o For EDIUS 11 Broadcast, see StreamlinePro11.2-Edius11-Plugin. 
 
 

• OPERATING SYSTEMS 
Windows Server 2019 ( Server )  
Windows Server 2022 ( Server ) 
Windows 10 ( Client ) 
 

• BROWSERS 
For Windows – Chrome 133.0 ( Client )  
For macOS – Chrome 133.0 and Safari 18.3 ( Client ) 
 

• EDITORS 
Adobe Premiere 2024 v24.5 ( Windows ) 
 

• SUPPORTED ROSS PRODUCT VERSIONS 
Streamline Xchange v10.2.0 
Streamline Xchange Adobe Panel v10.2.0 
Media I/O Suite v12.0 
Inception v17.2 
OverDrive v23.2 
 

• SUPPORTED THIRD PARTY PRODUCTS 
AP ENPS v9.5 
EDIUS X Workgroup v10.34 
EDIUS 11 Broadcast 
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VERSION 12.3.0 – OCTOBER 2024 

WHAT’S NEW 

• OPTION TO SET A DEFAULT FRAME RATE AND 
FRAME SIZE FOR TIMELINES 
You can now change the pre-configured system 
defaults for new timelines to use your preferred frame 
rate and default frame size.  

To change the default settings comissioners must add 
the following VM arguments: 
#To set the default Frame Size 
-Dmam.asset.timeline.default_frame_size="1920x1080" 

#To set the default Frame Rate 
-Dmam.asset.timeline.default_frame_rate="29.97(df)" 
 
 

BUGS ADDRESSED 

• Fixed an issue where the System Monitor displayed an incorrect error message on a 
successfully uploaded clip. (SP-1325) 

• Fixed an issue where videos failed to attach via the Streamline Pro NLE Plugin. (SP-
1346) 

• Fixed an issue where, after logging in, the Streamline Pro Plugin would not allow the 
user to use certain features. (SP-1375) 

• Fixed an issue that caused a segment to be added before the 00:00 point on a 
timeline. (SP-1386) 

• Fixed an issue where the Undo button was not usable after a segment was added to 
a newly created timeline. (SP-1391) 

 

  

 
Once configured, the default options will appear 
when you create a New Timeline. 
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CERTIFICATIONS 

• OPERATING SYSTEMS 
Windows Server 2019 ( Server )  
Windows Server 2022 ( Server ) 
Windows 10 ( Client ) 
 

• BROWSERS 
For Windows – Chrome 96.0 ( Client )  
For macOS – Chrome 96.0 and Safari 15.0 ( Client ) 
 

• EDITORS 
Adobe Premiere 2024 v24.5 ( Windows ) 
 

• SUPPORTED ROSS PRODUCT VERSIONS 
Streamline Xchange v10.1.7 
Streamline Xchange Adobe Panel v10.1.7 
Media I/O Suite v11.0 
Inception v17.2 
OverDrive v21.3 
 

• SUPPORTED THIRD PARTY PRODUCTS 
AP ENPS v9.5 
EDIUS X Workgroup v10.34 
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VERSION 12.2.0 – AUGUST 2024 

WHAT’S NEW 

• SUPPORT FOR ADDITIONAL FRAME RATE PRESETS  
You can now select from additional frame rates when you 
export your timeline, including 59.94fps or 50fps. You can 
find these new presets in the Timeline Editor > Export 
wizard under Export Settings. 
  

CERTIFICATIONS 

• OPERATING SYSTEMS 
Windows Server 2019 ( Server )  
Windows Server 2022 ( Server ) 
Windows 10 ( Client ) 
 

• BROWSERS 
For Windows – Chrome 96.0 ( Client )  
For macOS – Chrome 96.0 and Safari 15.0 ( Client ) 
 

• EDITORS 
Adobe Premiere 2024 v24.5 ( Windows ) 
 

• SUPPORTED ROSS PRODUCT VERSIONS 
Streamline Xchange v10.1.7 
Streamline Xchange Adobe Panel v10.1.7 
Media I/O Suite v11.0 
Inception v17.2 
OverDrive v21.3 
 

• SUPPORTED THIRD PARTY PRODUCTS 
AP ENPS v9.5 
EDIUS X Workgroup v10.34 

  

 
Timeline Editor Export Wizard 
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VERSION 12.1.0 – JULY 2024 

WHAT’S NEW 

•  ABILITY TO MOVE VIDEO OR AUDIO CLIPS TO DIFFERENT TRACKS IN THE 
TIMELINE EDITOR  
You can now move video or audio clips to different tracks in the Timeline Editor of 
the Streamline Pro Web Video Editor. 
 

 

 

 

 

BUGS ADDRESSED 

• STREAMLINE PRO WEB VIDEO EDITOR  

• Fixed an issue where the Timeline Editor playhead was not synced to the Preview 
Player. (SP-748) 

o Fixed an issue where trimming or extending linked segments with different 
lengths trimmed the clips to the same length. (SP-1077) 

o Fixed an issue where a Timeline name set to a blank space would be 
accepted. (SP-1103) 

o Fixed an issue where the audio meters did not play on some segments. 
(SP-1137) 

• Fixed an issue where the playhead stuttered during playback. (SP-1138) 

o Fixed an issue with a notification message that appeared when double-
clicking on Video or Audio assets in the Media Browser panel. (SP-1148) 

• Fixed an issue where opening another Timeline while the current Timeline is playing 
did not unload the video.  (SP-1154) 

• Fixed an issue where deleting the key when saving or creating a Timeline deleted the 
selected segment. (SP-1187) 

• Changed how the audio meter calculates loudness from LUFS to dBTP. (SP-1276) 

 
CLIPS IN THE MEDIA BROWSER CAN NOW BE MOVED 
TO YOUR PREFERRED TRACK. 

 
AN AUDIO CLIP IS MOVED FROM THE A2 TRACK TO THE 
A1 TRACK. 
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CERTIFICATIONS 

• OPERATING SYSTEMS 
Windows Server 2019 ( Server )  
Windows Server 2022 ( Server ) 
Windows 10 ( Client ) 
 

• BROWSERS 
For Windows – Chrome 96.0 ( Client )  
For macOS – Chrome 96.0 and Safari 15.0 ( Client ) 
 

• EDITORS 
Adobe Premiere 2024 v24.5 ( Windows ) 
 

• SUPPORTED ROSS PRODUCT VERSIONS 
Streamline Xchange v10.1.4 
Streamline Xchange Adobe Panel v10.1.4 
Media I/O Suite v11.0 
Inception v17.1.1 
Overdrive v21.3 
 

• SUPPORTED THIRD PARTY PRODUCTS 
AP ENPS v9.4 
EDIUS X Workgroup v10.34 
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VERSION 12.0.0 – JUNE 2024 

WHAT’S NEW 

• Streamline Pro Web Video Editor 
This lightweight editor allows you to modify hundreds of daily headlines, teases and 
voiceovers from your web browser. Edit content 30% faster compared to traditional 
industry standard tools! 

  
Streamline Pro Video Editor  
In Streamline Xchange, to open the Video Editor simply click the Video Editor tab. 
 
Features include: 

o Media Browser — Media assets from your MAM are 
right at your fingertips. Use advanced filters and 
search capabilities. 
 
 
 
 
 
 

• Timeline Editor — Once content is added to the Timeline 
Editor, you can trim, split or re-arrange your video and 
audio assets. 
 
 
 
 
 

 
Media Browser 
 

 
Timeline Editor 
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• Asset Preview Player — Preview assets and optionally use 
the  Mark In and  Mark Out buttons to select which part 
of the asset you wish to use. 
 
 
 
 

• Timeline Preview Player — Quickly view your latest edits in 
the Timeline Preview Player, and use the  Mark In and  
Mark Out buttons to select which part of the video you 
wish to export. 
 
 
 

• Support for Existing Streamline Workflows — Seamlessly 
open the Video Editor in your web-browser directly from 
the Streamline Xchange MAM. Export your content using 
your preferred video codec and upload it to a placeholder 
in your NRCS system. 
 
 

• Audio Levels 
You can preview audio levels using the Audio Meter, and 
adjust the gain using the Audio Leveller tool in the 
Timeline. 
 
 
 
 
 

• Open Timelines in Adobe Premiere — If you’d like to make 
more detailed edits to your Timeline in Adobe Premiere, 
simply open your imported Timeline directly in the Adobe 
Premiere interface. 

 

 

 

 

 

       
Audio Meter & Audio Leveller 
 

 
Asset Preview Player | Timeline Preview Player 
 

 
Timeline Preview Player Menu 
 

 
Export Wizard Dialog 
 

 
Imported Timeline in Adobe Premiere 
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UPGRADE CONSIDERATIONS 

• LICENSING REQUIREMENTS 
To access the Streamline Pro Web Video Editor, you must reach out to a Ross Video 
Sales Representative to purchase a new license to enable the feature. 

 

CERTIFICATIONS 

UPGRADE NOTE 
Streamline Pro and Streamline Xchange cannot be installed on mixed OS 
environments (for example, Streamline Pro on Linux and Streamline Xchange on 
Windows or the reverse). 
 

• OPERATING SYSTEMS 
Windows Server 2019 ( Server )  
Windows Server 2022 ( Server ) 
Windows 10 ( Client ) 
 

• BROWSERS 
For Windows – Chrome 96.0 ( Client )  
For macOS – Chrome 96.0 and Safari 15.0 ( Client ) 
 

• EDITORS 
Adobe Premiere 2024 v24.5 ( Windows ) 
 

• SUPPORTED ROSS PRODUCT VERSIONS 
Streamline Xchange v10.1.3 
Streamline Xchange Adobe Panel v10.1.3 
Media I/O Suite v11.0 
Inception v17.1.1 
Overdrive v21.3 
 

• SUPPORTED THIRD PARTY PRODUCTS 
AP ENPS v9.4 
EDIUS X Workgroup v10.34 

 

 

 

  



 

 

    VERSION 12.5.0   JULY 2025 

VERSION 11.2.1 – OCTOBER 2024 

BUGS ADDRESSED 

• Fixed an issue where the System Monitor occasionally displayed an error 
message for a successfully uploaded clip. (SP-1325) 

• Fixed an issue where videos failed to attach via the Streamline Pro NLE 
Plugin. (SP-1346) 

• Fixed an issue where, after logging in, the Streamline Pro Plugin would not 
allow the user to use features, including loading filters, searching, and 
logging out. (SP-1375) 

 

CERTIFICATIONS 

• OPERATING SYSTEMS 
Windows Server 2019 ( Server )  
Windows Server 2022 ( Server ) 
Windows 10 ( Client ) 
 

• BROWSERS 
For Windows - Chrome 96.0 ( Client )  
For macOS – Chrome 96.0 and Safari 15.0 ( Client ) 
 

• EDITORS 
Adobe Premiere 2022 (v22.3.1 — Build 2) ( Windows ) 
 

• SUPPORTED ROSS PRODUCT VERSIONS 
Streamline Xchange v10.1.0 
Streamline Xchange Adobe Panel v10.1.0 
Workflow Suite v8.2.1 
Inception v16.0.0 
Overdrive v21.3 
 

• SUPPORTED THIRD PARTY PRODUCTS 
AP ENPS v9.4 
EDIUS X Workgroup v10.34 
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VERSION 11.2.0 – DECEMBER 2023 

WHAT’S NEW 

• SUPPORTS EDIUS X WORKGROUP FOR NEWS 
WORKFLOWS 
The Streamline Pro (NLE) Plugin now supports EDIUS 
news workflows. In the EDIUS interface, simply navigate to 
Tools > Streamline Pro Plugin to open it. 
 

o Import Multiple Assets — You can import one or 
multiple assets from the Streamline Pro Plugin. 
 
 
 
 
 

 
 

 
 

o Export Wizard — Export placeholders with ease 
using the Streamline Pro (NLE) Plugin’s Export 
wizard. 
 
 
 
 

 

 
 

 
 

 

• Admin Features — Administrators can use a Windows Batch File to facilitate 
installation processes and use new Logging capabilities to diagnose issues.  
 

 

 
Export Wizard  
In EDIUS, go to File > Export > Print to File. Use 
the Streamline Pro Exporter Preset and the 
Export wizard opens in the plugin. 

 
EDIUS User Interface (UI) Tools Menu 
Navigate to Tools > Streamline Pro. 

 
Streamline Pro (NLE) Plugin 
Displays selected assets ready for import. 
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• USER INTERFACE ENHANCEMENTS TO STREAMLINE PRO PLUGIN (MOS & NLE*) 
*NOTE: The Streamline Pro plugin is available in two versions: one for MOS newsrooms, such as Ross 
Inception, and another for Non-Linear Editors, such as EDIUS. Features may vary based on restrictions 
in development with third-party applications. 
 

o Access to Projects — Users can now search for 
assets based on their project in the Projects tab of 
the Streamline Pro (NLE) Plugin. 
 
 
 
 

• Access to Smartbins — Users can now search for assets 
using smartbins in the Smartbins tab of the Streamline Pro 
(NLE) Plugin.  
 
 
 
 

o New Selection Counter — A selection counter 
displays the number of items selected in the bottom 
right corner of the Streamline Pro Plugin. 

 

 
 

 

BUGS ADDRESSED 

• Fixed an issue where assets remained selected even when the view was changed. 
(SP-68) 

• Fixed an issue where placeholders couldn’t be created from ENPS stories that 
exceeded 5000 characters. (SP-199) 

• Fixed an issue where padding did not appear between assets in the Asset view area 
of the Streamline Pro (NLE) plugin. (SP-245) 

 

  

 
Selection Counter  

 
Projects Tab  

 
Smartbins Tab  
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CERTIFICATIONS 

UPGRADE NOTE 
Streamline Pro and Streamline Xchange cannot be installed on mixed OS 
environments (for example, Streamline Pro on Linux and Streamline Xchange on 
Windows or the reverse). 
 

• OPERATING SYSTEMS 
Windows Server 2019 ( Server )  
Windows Server 2022 ( Server ) 
Windows 10 ( Client ) 
 

• BROWSERS 
For Windows - Chrome 96.0 ( Client )  
For macOS – Chrome 96.0 and Safari 15.0 ( Client ) 
 

• EDITORS 
Adobe Premiere 2022 (v22.3.1 — Build 2) ( Windows ) 
 

• SUPPORTED ROSS PRODUCT VERSIONS 
Streamline Xchange v10.1.0 
Streamline Xchange Adobe Panel v10.1.0 
Workflow Suite v8.2.1 
Inception v16.0.0 
Overdrive v21.3 
 

• SUPPORTED THIRD PARTY PRODUCTS 
AP ENPS v9.4 
EDIUS X Workgroup v10.34 
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VERSION 11.1.0 – SEPTEMBER 2023 

WHAT’S NEW 

• SUPPORT FOR PLACEHOLDER WATCH FOLDER WORKFLOW 

Video editors can now register a file to a placeholder using a watch folder. 
(PRM-1737) 

• OPTION TO TURN OFF TARGET INFORMATION IN MOS OBJECT 

Comissioners can use a new VM argument that, when set to true, allows 
you to disable the target information to support third party integrations that 
require the objID field. (PRM-1852) 
 
#To set the Asset ID 

-Dstreamline.mosobj.remove_target_info=true 

 

• ENFORCE DEFAULT TARGET AS PLAYOUT LOCATION 

Producers can transfer files to a playout device automatically once a rundown 
is monitored. Includes support for the new option to turn off target 
information. (PRM-1688) 

• NEW 'AssetID' OPTION IN FILE STORAGE NAMING RULES 

There is a new file storage naming rule that renames the file using the asset 
ID instead of the name. For example, a parachuting.mxf file with the asset 
ID of 4351, would be renamed 4351.mxf when it’s sent to storage.  
(PRM-1837) 

 

BUGS ADDRESSED 

• Fixed a usability issue affecting large monitors, where the scroll bar 
malfunctioned when the search criteria matched 50 or more assets.  
(PRM-1767) 

• Fixed a login issue, where administrators attempting 
to log in to Streamline Pro without configuring the 
settings to use Streamline Xchange triggered an 
error. (PRM-1788) 
 
 
 
 

 
Error Message 
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• Fixed a placeholder error, where placeholders with the same name in a 
rundown fails on the second time. (PRM-1836) 

 

CERTIFICATIONS 

UPGRADE NOTE 
Streamline Pro and Streamline Xchange cannot be installed on mixed OS 
environments (for example, Streamline Pro on Linux and Streamline Xchange on 
Windows or the reverse). 
 

• OPERATING SYSTEMS 
Windows Server 2019 ( Server )  
Windows Server 2022 ( Server ) 
Windows 10 ( Client ) 
 

• BROWSERS 
For Windows - Chrome 96.0 ( Client )  
For macOS – Chrome 96.0 and Safari 15.0 ( Client )  
 

• EDITORS 
Adobe Premiere 2022 (v22.3.1 — Build 2) ( Windows ) 
 

• SUPPORTED ROSS PRODUCT VERSIONS 
Streamline Xchange v10.0.6 
Streamline Xchange Adobe Panel v10.0.6 
Workflow Suite v8.2.1 
Inception v15.7.1 
Overdrive v21.3 
 

• SUPPORTED THIRD PARTY PRODUCTS 
AP ENPS v9.3, v9.4 
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VERSION 11.0.0 – JUNE 2023 

WHAT’S NEW 

• STREAMLINE PRO 
Streamline Pro is a Media Asset Management (MAM) platform that leverages 
our existing Streamline Xchange MAM and Streamline Classic system to 
provide an end-to-end news worklow for video playout.  
 

• STREAMLINE PRO MOS PLUGIN 
Streamline Pro MOS plugin provides a simple interface for your video content 
creation and playout workflows.  

 
 

• SUPPORT FOR MOS PRODUCTION WORKFLOWS  
Integrates with Ross Inception and AP ENPS newsrooms for video content 
delivery. 

 

• MEDIA PLAYER FOR ASSET PREVIEWS 
Media player displays previews of the selected video 
asset. 
 

 

 

 

 

 
Media Player 
Displays a preview of the selected video clip. 
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• ADD ASSET TO STORIES VIA DRAG AND DROP 
Intuitive drag and drop of assets into Inception 
Newsroom stories. 
 
 
 
 

• SEARCH TOOL AND FILTER 
Search by unique ID, category, or any of your custom fields. Filtering allows 
you to ensure that only assets that meet your preferred search criteria will 
appear in the results. 
 

• ROSS INTEGRATION 
Streamline Pro offers compatibility with the following Ross Video products 
including Media I/O, Workflow Suite, and Streamline Xchange. See the 
CERTIFICATIONS section below for more details on supported Ross Video 
products and other vendors. 
 

CERTIFICATIONS 

• OPERATING SYSTEMS 
Windows Server 2019 ( Server )  
Windows Server 2022 ( Server ) 
Windows 10 ( Client )  

• BROWSERS 
For Windows - Chrome 96.0 ( Client )  
For macOS – Chrome 96.0 and Safari 15.0 ( Client )  

• EDITORS 
Adobe Premiere 2022 (v22.3.1 — Build 2) ( Windows )  

• SUPPORTED ROSS PRODUCT VERSIONS 
Streamline Xchange v10.0.5 
Workflow Suite v8.1.0 
Inception v15.7.1 
Overdrive v21.3 
Streamline Xchange Adobe Panel v10.0.5 

• SUPPORTED THIRD PARTY PRODUCTS 
ENPS v9.3 

  

 
Inception News UI 
Displays a user adding assets from Streamline 
Pro into an Inception newsroom story. 
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REQUIREMENTS 

• SSL CERTIFICATE REQUIREMENTS 
Due to browser security constraints Streamline Pro web client requires that 
you have a secure SSL setup. Administrators can find instructions to 
configure SSL certificates in the Streamline Pro Installation Guide. 

IMPORTANT:  
If you do not have the proper SSL certificates installed your web browser may 
display a certificate authority error message and prevent you from connecting 
to your web client URL. If you bypass the error, you may experience issues 
with the search results — including a lack of results appearing, or issues with 
the displayed Images and Thumbnails. 
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KNOWN ISSUES 
Please refer to the list below for any known issues that were identified at the time of the  
Streamline Pro release. This list is updated with each release, and resolved issues are 
removed. 

• OVERDRIVE 
Thumbnails for fulfilled placeholders in OverDrive may occasionally require a 
refresh to appear. (PRM-2014)  
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GETTING HELP 
• Streamline Pro’s Online Help system opens in your default web browser.  

• Our 24-hour hotline service provides access to technical expertise around the 
clock. After-sales service and technical support is provided directly by Ross 
Video personnel.  

• During business hours (Eastern Standard Time), technical support personnel 
are available by telephone.  

• After hours and on weekends, emergency technical support is available. A 
telephone-answering device will provide the names and phone numbers of 
technical support and field service personnel who are on call. These people 
are available to react to any problem and to do whatever is necessary to 
ensure customer satisfaction. For serious issue which need urgent attention 
and tracking, please ensure you are given a ticket number and refer to this in 
future communications. 

• Technical Support: (+1) 613-652-4886  

• After Hours Emergency: (+1) 613-349-0006 
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